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2 POINTS OF CONTACT
e Business representatives come into classroom during three-week spreadsheets unit (x1)
o  Workplace visit (x1)

1. Business representatives come into classroom, infroduce themselves to the students,
background to accounting, their careers and how IT and spreadsheets are used in the
industry. Student activity: Interactive spreadsheets presentation using excel shortcuts and
Copycat Limited exercise.

2. Workplace visit: Includes overview of the wider company, its employees, offices around
the world etc. Student tour of bank branch, meeting staff and hearing about different
careers. Seeing accounting ‘behind the scenes’. Student activity: Exercise showing
students what a typical accounting job looks like and a few Xero fips and tricks.
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CONTENT WE WILL COVER

Useful keyboard shortcuts

Page Setup

Paste Special —Values / Formula / Transpose
Copy / Paste Visible Cells

Filters

Text to Columns

Conditional Formatting

Lists

Pivot Tables

Formula —SUM / SUMIF / VLOOKUP / IF / IFERROR / LEFT / RIGHT /
SUBTOTAL

Useful keyboard shortcuts

USEFUL QUICK KEYS

Select Row = Shift + Spacebar
Select Column = Ctrl + Spacebar
Highlight multiple cells = Shift + Arrow keys
Step into a cell = F2
Absolute and Relative References = F4
— Note, there are several iterations when copying formula
— $CS$4 = maintains cell as point of reference
— (CS$4 = maintains row as a point of reference
— $C4 = maintains column as a point of reference
* Go to the bottom / top / left / right of a data set = END + Arrow keys

DISCLAIMER: SSEP Activity examples have been created by the school and employer accredited to fit the curriculum and student
body of a particular cohort. The purpose of the SSEP activity example is not to be prescriptive, but to provide and share ideas between

SSEP schools and employer partners. Any SSEP activities should be designed or adapted according to the individual requirements and For more on SSEP see:
capabilities of the teacher, employer and student participants. Smart Waikato Trust has made every effort to ensure information in this
document is correct at time of publishing. Neither Smart Waikato Trust nor the creators of this example assume liability and hereby www.smartnz.nz
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PAGE SETUP

INSERT | PAGELAYOUT | FORMULAS DATA REVIEW VIEW KPMG  DEVELOPER |

R e e
Margins Orientation s:e ;m;l Breaks Background Print 1] Heigh: = il
g sing

Page | Margns | Mesderaoter | Sheet
Pt aren: | A10602
Prnt tles

Bows 10 repeat at top:
Columns to repest at eft:

P

L ack and white Cell grrors as:  displayed
1] Oratt guality

(] Row and cofuma headings

Page order

(®) pown then over
) Oger. then down

PASTE SPECIAL — VALUES / FORMULA /
TRANSPOSE ETC

* Short key = ALT + E then S

Paste
®)|all] ) Al using Source theme

O yalues O column widths
O Formats () Fogmulas and number formats
) comments () Valyes and number formats
O validation All merging conditional formats
Operation
®© None O Mutiply

O agd O oivide
O subtract

) sep lans

| asteyink |

DISCLAIMER: SSEP Activity examples have been created by the school and employer accredited to fit the curriculum and student
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COPY / PASTE VISIBLE CELLS

Select data
Short key = CTRL + G or F5

) Roy differences
O Column differences
O Precedents

V! Numbers () Dependents

W Text @ Direct only

! Logicals () All levels

! Errors ast cel
G
Oc‘urunt[egion ./ Conditional forma
) current array ) pata validation
O objects ® al

' Same

FILTERS

Ensure you have selected the cell or row you want to filter
Short key = CTRL + SHIFT + L
Data -> Filter

HOME  INSERT  PAGE LAYOUT  FORMULAS REVIEW _ VIEW  KPMG

@ [% [% D;} ”=e [ Connections

Properties 7% Reappl
From From From From Other | Existing Refresh Ehi Filter | it

Access Web Text Sources= Connections —All= e Eit Links Advanced
Get External Data Connections Sort & Filter

DISCLAIMER: SSEP Activity examples have been created by the school and employer accredited to fit the curriculum and student
body of a particular cohort. The purpose of the SSEP activity example is not to be prescriptive, but to provide and share ideas between
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CONDITIONAL FORMATTING

Home -> Conditional Formatting - > New Rule -> Format cells that contain.

S@EHODe®H L > o g - Excel Examplesxlsx - Excel
| HOME || INSERT  PAGELAYOUT ~FORMULAS DATA REVIEW VIEW KPMG DEVELOPER WORKSIE kPG

- - | | I r L | 1|
|Calibri (1 c|A A F==|¥- |EPWrapText General B )
| W»- | Ewe l P =
o WSS = 3w - - «o x| Conditional formatas Cell
¥ Format Painter BoTAU H-la-A = | &= = | EMerge & Center $-% 0 [® 3 Formatting = [Table ~ SMCS.‘
Clipboard " " Alignment o Number - byles.

Data -> Text to Columns
Ensure that data is selected that you want to split

HOME  INSERT  PAGELAYOUT  FORMULAS [DATA | REVIEW  VIEW KPMG  DEVELOPER ~ WORKSITE

B | B RETaE|Y I |&(E 18

= [Z Properties . VReapply ’
From From From From Other | Existing | Refresh = Zl Sort | Filter Textto |Flash Remove
Access Web Text Sources~ Connections = All~ [ech Ediit Links W Advanced Columns | Fill Duplicates

Get External Data Connections Sort & Filter

Delimited — common The Text Wizard has determined that your data is Fixed Wicth.
. L )\ # thisis correct, choose Net. or choase the data type that best describes your data.
Fixed width — on occasion ongoa e
Choose the file type that best descrbes your data:
(O pelmited - Characters such as commas or tabs separate each field.
(® [foxed yocth] - Fields are aligned in columns with spaces between each fiekd

Preview of selected data:

00 Sales 1000

00 COGS -200
Operating -100

00 Admin -$0
Finance -50
Tax -162

DISCLAIMER: SSEP Activity examples have been created by the school and employer accredited to fit the curriculum and student
body of a particular cohort. The purpose of the SSEP activity example is not to be prescriptive, but to provide and share ideas between
SSEP schools and employer partners. Any SSEP activities should be designed or adapted according to the individual requirements and For more on SSEP see:
capabilities of the teacher, employer and student participants. Smart Waikato Trust has made every effort to ensure information in this
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* Data-> Data Validation
* Allow = List
* Source = Select data set

ORI = mopes
from Ffrom From FromOther  Existing |Refresh
Connections | All = e Edit Links
Connections

[l insentiisthere

ADply these changes 10 all other cells wih the same settings

oL

PIVOT TABLE

Ensure your data set has headers
Select the data set
Insert -> Pivot Table

You now have the option to put the fields in your pivot. You can drag or
click

Bo ¢ ROE DML ~¥ .-
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW

PivotTable Recommended Table | Pictures Online Shapes SmartArt Screenshot Y]
PivotTables Pictures  ~ =

Tables lllustrations

DISCLAIMER: SSEP Activity examples have been created by the school and employer accredited to fit the curriculum and student
body of a particular cohort. The purpose of the SSEP activity example is not to be prescriptive, but to provide and share ideas between
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FORMULA

VLOOKUP allows you to lookup a value in a data set
— Formula -> =vlookup(Array, Data set, Column to look up, 0)
— 0="false (exact)
— Similar to a sumif but only takes first value in lookup

IF is a logic formula. Basically you are validating information e.g. if cell X =
Apple, then | want YES to show, if it isnt, then | want NO to show

— Formula -> =IF(CellX="Apple”*YES”,“NO")
— You can look for an exact match or range using =,=<,=>,<,>, or both
— Whenever using text in a formula it needs to be within

IFERROR is similar to an IF formula, however this formula applies a logic
where there is an error in the formula e.g. IFERROR in cell X then 0.

— Formula -> =IFERROR(CelIX,”YES”)
— Yes can be replaced with a formula, text or value.

“u u

— Usually applied to a viookup formula

FORMULA

Use SUM to sum a set of data. Note, a sum will also include hidden cells.
— Shortcut -> ALT =
— Formula -> =SUM(Range)

LEFT / RIGHT allows you to select certain values/text in a cell from the left
or the right.

— Formula -> =LEFT(cell, num chars)
— Formula -> =RIGHT(cell, num chars)

SUMIF sums a set of data based on a criteria. Effectively, the range is the
data set, the criteria is what you want to sum and the sum range is the
values that you want to sum.

— Formula -> =SUMIF(Range, Criteria, Sum of Range)

DISCLAIMER: SSEP Activity examples have been created by the school and employer accredited to fit the curriculum and student
body of a particular cohort. The purpose of the SSEP activity example is not to be prescriptive, but to provide and share ideas between
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Excel Shortcuts by Operation

e Reeon | ke fucten |

Farmarting Ediring

Crl + 1 [Dpana Call Formats dislog Boo® FZ | Go ints edit moda
Sl Fodwabtn b ooy s sted L1 T by o] Z1rias o Tubks s Bl i Bt ' E il Ehifi & EZ |G oo sl i comdviivss iis
Data formmat F4 | Rapaat the et scticom OR
Col 4+ Shift + Ganaral format afezhed tha tall releresza fin
Col 4 Shit + 1 | Numibiar fodmst i e |
Col 4 Shit + 2 | Tirmes Tormmsat F? | Epall chack
Col 4 Shik + 3 |Dataformea FS | Ehaa tha niunne s cUtHut
Col 4 Shit + & | Curency Tormt ol g il Pt Pesrrnici b [im
Col 4+ Shit + & ||Percent formst it o |
Corl + Shift + # | Expoment formnet Cul = £ Undo thee last acton
Fanrs Cul = ¥ | Rl thes Liit SeLion
Col 4 Shit + F |[Call Formets diakog box - Fom Col = F | Dpans Find diakog bos
cml & 8  Bobkddom Col = H | Opand Faglses daloeg bos
Cul + I |l feat Ehit =+ R |Fmd again
Crl + U | Unearlin font Cul = Ented | Apply tha cunnemt edits in
Crl + 2 |[Toggh bedd Tormmila bar oo avany ol
Crl + 3 |[Toggh itk ELT LRy deil DY
Crl + & |[Toggh umdsifine AR+ Enbed| Moy ioa mesa lins Din st
Crl + &5 [Togghs striksthicugh i
Bovohis s Col & Dl | Dedaitin 1o aind of lin [in adh
Col 4+ Shit + 7 |Dutlices Bordar o
Corl 4+ Shift + - || Fivere Baordars SrrLcted
Mavigetazn Cil & = | st call pow, o eodiemin
F5 |Opars GoTo dialsg bas il & - Dedwrti el Tosar, &1 ook mi
Honrd Go to i Tirst ool im thi pow Cal = 9 | Hide rowa
End | Go to end mioda Cil = O | Hichs oo b s
Cirl  + Hoirs Go oo thi Tirst el (&1) Cirl & Bhift = S | Unhide roas
Crl + End |Go oo thi bs sctive osll in Cirl + Ehift = O [ Unhide codumning
tha shest Shift & Epsos Sl row
Cirl 4+ Pglip Go oo peres ks b Copy' and Fasne
Cirl 4+ PgDm| Go oo ress® alviest Cul = O | Copty the Do imost call im
At & Pglhn Laft o Sashdd & Siliction of ealls oo @
Alt 4+ PgDn| Right ond Schaan highlighed call bakos
Crl + Tab |Go oo et workbook Cul = R [Copy the i most csll ina
Col 4 Shit + Tab |Go oo phe oo workbook saleztion of calls 1o aeary
Crrl  + Arroe, Mo 10 the adga of regisn highlighved el 12 the right
Rersiawving Cul = Copy the Aosimniils from tha
F5 | Dpars GoTo diaksy bax £l | sbaei the Bctiva call into
Crl + | Ehow inconsistenm calls this Pormila b
in sarlocted rows Cirl + Bhifi = Copey the value from tha call
Cerl 4 Shift + i | By |moeO it oalls ailtecrve ol acthen ool imo
in daietid el tha formmila bar
[ i ; Y T oy i T i B i Col = C Copty desl e tasn
Carl T i PfGEACGL O Chie Col & X [Cut sabsction
el el € Cuwl = % |Paila
il 4+ 1 | Trisezi cap=sincant on thi Cirl + & = ¥ |[Dpaens Pasta Special dislog
el el € bz
Col 4+ Shit + Triezin ] pracadents o tie Caledilation
el el € FS | Rl e ha b Gl w0 richoa s
Corl & Shift + 1 [ Trzcae sl depandants on tha Ehift = F3 | Recakuboe woisheat
i (7l sl M vtiedi
Taeneral Cul = FZ | Dy Naivee Pl gai dislog
Cirl + O [Dpanworkbook diahosy bean
Cirl + 5 |Esvaworkbook Cirl & Ehift = F3 [Crasbe manmss Troom selectomn
Crl + P [Dpana Print diskog box Macres
Crl + W | Do vwioribasok AR+ R Dpaens Macio diskog box
At 4+ F& | Cloda Bosad A+ F11 Opans VEA Editog
F1Z |Eava as Hasle
FAO [ Sethale s Fi | Help i
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File Home Insert Draw Page Layout Formulas Data Review View Nuance PDF ¢/ Tell me what you want
o PROTECTED VIEW Be careful—email attachments can contain viruses, Unless you need to edit, it's safer to stay in Protected View. Enable Editing
c7 - J || =ROUND{(RAND{)*50),2)
A B = D E F G H | J K
1 -
= |Copycat Limited
3 -
4 |Copycat Limited is a printing specialist based in Hamilton. We have been asked to run some financial scenarios for them to better analyse their employee productivity.
£
& |[Employee Department  |Hours Week1  Hours Week2  Hours Week3  Hours Week4  |Total Hours This Month |Department |Tota| Hours This Month |
7 |Gaylene Johnston  |Admin [ 127 39.3 6.8 27.6 [insert list here [sumiF
8 |Janice Watson Admin 12.9 23.5 444 47.7|
9 |Bob Dylan Sales 8.6 25.5 4.1 39.4]
10 |Sanjay Patel Sales 30.7 24.4 33.0 43.2] Enter departments here
11 |Ellen Chan Printing 48.1 30.3 2.9 24.3
12 | Tamati Tangaroa Printing 43.5 13.9 35.1 20.0
13_Jske Patu Maintenance 33.3 42.2 45.6 11.0
14 |James Burns T 118 22.8 20.1 29.8|
15 |Lee Swagger Printing 16.2 36.9 24.6 25.1
16 |Allen Burns Admin 15.1 0.3 44.1 26.2
17_Juhr| Jones Printing 27.9 14.2 22.6 34.9
18 |Hank Thomas Printing 20.6. 29.5 45.8 30.4]
19 |Ryco Cena Maintenance 34.9 27.4 20.9 2.8
20 |James Reynolds T 34.0 239 27.3 219
21 |Guy Reynolds Printing 8.7 26.1 21.5 0.4]
22 |Naomi Jones Printing 16.8 16.0 17.0 33.7
23|
24 |
25 |
26 |
27 |
Data 14
Ready

Step 1: Separate first and last names using text to columns. Note: make sure to add new column
first.

Step 2: Copy and paste special values over formulas generating random numbers.

Step 3: Sum total hours worked for the month. Alt + equals.

Step 4: Apply filters to data set.

Step 5: Extract data for Admin department only using copy visible values. New Sheet.

Step 6: Create a list of the different departments (manual input needed).

Step 7: Use sumlF function to calculate number of hours worked in a month for different
departments.

Step 8: Apply conditional formatting to show employees who has worked less than 7.5 hours
showing up as red.

Step 9: Create a pivot table of the data. Filter by department, names in the rows and hours
worked as values. New Sheet.

Teacher note: This material goes beyond what is ordinarily taught at Year 10 level and was
designed for more advanced students. The material would need to be pared back and/or
co-delivered with the teacher for most students at this level.

For more on SSEP see:
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